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ACCC SOFTBALL TEAM STARTS IN MAY.  SIGN UP TO 

JOIN THE FUN!  ALL SKILL LEVELS ARE WELCOME.

GAMES ARE IN THE EVENINGS AT 6, ON BASE, SO

BRING THE KIDS AND A GLOVE AND BE READY FOR

LOTS OF FUN!
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CLASSROOM HAPPENINGS


EARTHLING ROOM:
















Classroom Wish Lists





Earthling Room:


Dust Buster


Small Microwave


Children’s Music CDs





Pioneer Room:


Gymboree Bubbles


Dry Erase Markers – in lots of different colors





Mercury Room:


Inside classroom balls – any size, texture





Viking Room:


Filing Cabinet or filing boxes





Gemini Room:


Story Tapes


Puzzles





Apollo Room:


Black microwave containers that come with a meal on it – we need the containers for art projects (not the food!)





Vanguard Room:


Vegetable/Flower seed packets for the science table


Scented water color markers





Office:


Recycled paper for inner office copying





ACCC Birthdays for April





Clarence Lau		1 Year Old


Benjamin Walton	2 Years Old


Kyle Lawrence	2 Years Old


Tyler Shaw		3 Years Old	


Matthew Balboni	3 Years Old


Alysia Korsmeyer	5 Years Old








Welcome to the World!!





Paul Wesley Sandford


Born March 7, 1999 at 2:22 am


7lbs. 9oz. 	21 1/2” long





Nathan Cole Machak


Born April 16, 1999 at 7:09pm


9lbs.  	19 1/2” long








	


“IT ISN’T LIFE THAT MATTERS, 


	IT’S THE COURAGE YOU BRING 


	TO IT” –HUGH  WALPOLE











New Newsletter Hits Ames Child Care Center 


Do you have the winning title?


Naming contest underway!





It is time to test your creative juices.  There is a contest going on right now.  Who can come up with a catchy title for our new Newsletter?  The staff will vote on their three favorite and then there will be an all center vote from those three.  The Grand Prize will be $10 off a weeks tuition, the two runners up will get $3 off.  So turn on those thinking caps and see what you can come up with.  What have you got to lose?  All entries must be turned in by Tuesday June 15. 


Along with newcomers Harena and Mara, the Earthling Room welcomed Keely  Corral as a permanent teacher in the room.  Keely joins Lori and Ann who all stay busy creating an exciting environment for our youngest ACCC members.





PIONEER ROOM:


The Pioneer Room stayed busy as they welcomed recent Earthling graduates Zachary, Natasha, and Jared.  Though they were sad to say some good-byes, new additions to the room were exciting.  The Pioneer Room has done a lot of art and sensory activities this past month.  Just look on the walls in the classroom you will find lots of evidence of the fun they have had fingerpainting, contact paper collages, stickers and much more. 





MERCURY ROOM:


The Mercury Room happily greeted Alyssa, Timothy, Craig and their families as they made the big move into the Mercury Room.  Their time has been spent exploring outside as we enjoy more and more sunshine.  They have also been working on a few new self help skills such as clearing their lunch dishes and climbing up onto the changing table.  All of the Mercuries are in for some new and exciting challenges!





VIKING ROOM:


The children in the Viking Room spent  a lot of time in the past month learning some new skills and practicing some old ones!  They had fun cracking peanuts.  Their little fingers and teeth worked hard on the nuts and they enjoyed every bite.  There was lots of singing and dancing going on.  The exciting part was that they began dancing with a partner and learning to share space.  They practiced problem solving and listening skills by working their way through an obstacle course.  


The future holds a lot of new, exciting experiences for the older toddlers.  They will make cards for Mother’s Day by choosing pictures from a magazine that looks like mom.  They will be practicing some sensory skills by smelling spices, making a fruit salad, and using visual memory in “what’s missing?”.  Lots of growing going on in that room!





GEMINI ROOM:


The Geminis are having fun with learning new songs that their classmate Matthew Balboni is teaching them. For example a huge hit is “I’ve been working on the railroad”.  They are also really enjoying time spent listening to story tapes and experimenting with their ABCs.


	In the coming month the Geminis will say 





some good-byes to old classmates and welcome new ones, all the while discovering what it is like growing up to be a preschooler!





APOLLO ROOM:


	During April, we learned about many typical Spring happenings and are continuing this line of exploration into May.  Some of the areas we covered are farm animals and baby animals, Spring weather, birds, and insects.


	Soon we will be doing some planting activities in our classroom and a lot of creative play around the theme of camping!





VANGUARD ROOM:


	During the month of April we’ve explored M, N, O, P, Q.  We learned about their shape and sounds.  Our activities helped us relate to each letter.  We used marbles for sorting, painting, and classified different kinds of nuts, and acted out Nursery Rhymes.  Our art table is very popular; there are always happy children using markers, scissors, and tape.


In the next few weeks, we will be making Mother’s Day gifts, Parent’s Day gifts, doing some planting, sprouting, and lots more fun, exciting activities.








	

















Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(
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	   Water Safety


Learning to swim is fun, but also a wise investment for teaching water safety.  NO matter what, children should never be around water unsupervised by adults.


DROWNING CAN OCCUR IN LESS THAN TWO INCHES OF WATER IN A MATTER OF SECONDS!


Even small buckets or wading pools with a few inches of water collected in the bottom can prove hazardous to young children.  


For water fun, consider mixing some water in the sandbox or let children romp in the sprinkler.





	





Calendar of Events For May


ACCC Staff Meeting


ACCC Vanguard Room


 Wed. May 19 @ 5:15pm


Please help out if you can and cover a classroom or pick your child up early.  


ACCC Parent Meeting


Bldg 258 Auditorium


Wed. May 26 @ Noon


Come discuss the new facility, BoD elections, and much more.


Memorial Day Holiday – ACCC Closed


Mon. May 31








Special Event


Place


Time


Type a description of your event here.











  


 “Now, how would you like it if…?”





	Adults often ask children, “Now, how would you like it if…?’ as in “Now, how would you like it if someone interrupted you while you were talking to a friend?”  or, “How would you like it if someone stood right in front of the TV when you were watching?”  We want them to see our viewpoint.


	But what if kids were doing the asking instead?  What, for example, would a two-year-old’s “Now, how would you like it if…” questions be for the adults in his life?  They might go something like this:  “How would you like it…


	…  if you had to eat a big plateful of food when you weren’t hungry?”


	…  if everyone laughed when you said something serious?”


	…  if someone told you to hurry because it was time to go, and then stood there talking and talking to a friend?”


	…  if you had to go to bed when you weren’t sleepy?”


	…  if people carried on as though the Atlantic Ocean was spilling across the table instead of a small glass of milk?”�	…  if you were told to stop all that crying even though you were really sad?”


	…  if what you were especially good at was running and jumping and climbing,  but running and jumping and climbing wasn’t allowed?”


	Every once in a while it helps to stop and speculate about what your child’s “Now, how would you like it if…?’ questions would be.  Figuring out his or her viewpoint can ease tensions, especially if you’re having a long or frustrating day with an active toddler.











Thank You To:





Earthlings:


The Hines for a new clock


The Palmers for donating toys


Laura for donating toys





Pioneers:


Tom Maier for making a new gate





Apollos:


To all of the parents who supported our class by helping with our pancake breakfast fundraiser with their time and resources.  And a great big thank you to all who supported us by buying breakfast that morning!





Vikings:


Jenny Kahn for a variety of dress up costumes


Cory Finn for her time and talent singing and playing the guitar with all the toddlers


Mary Olynick for a new filter and fish for the fish tank in the room


Homa Tay for lots of new goldfish





Office:


Kevin Gregory for recycled paper for copying


Deb Wood for copy paper


Richard Asano for recycled paper


Tracy King for lots of Xerox boxes so that we can get organized!





* 	*	*	*	*	*


A very special thank you goes out to all of the parents who so generously sponsored staff members and their dates so that we could attend the Swing With The Stars recognition dinner.  We had a wonderful time and your support was greatly appreciated!  Thank you, Thank you, Thank you, Thank you…………………… 


*	*	*	*	*	*





Family Fun


Table Art:


	A guaranteed way to enjoy each other at mealtime!  Purchase a paper or plastic tablecloth on your next shopping trip and place it on the table with crayons.


	Gather the entire Family around the table before dinner or on a special occasion and let them draw designs on the tablecloth for decoration.  The tablecloth becomes a “canvas” and the time spent together becomes a priceless memory of family togetherness!





Flannel Board Fun:


	What can you do with an old baby blanket?  How about turning it into a large flannel board for story telling adventures?


	You can easily make the board by taping the edges to a large piece of sturdy cardboard.    Older children can cut additional flannel or felt into shapes or into story book characters.  You will delight your children if you join in the fun with a story of your own!



























































     Thoughts To Ponder





Thank You To: 
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